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1. Le paragraphe

1.1. Définition

La définition du paragraphe en Traitement de texte est très différente  de sa 
définition littéraire.

Un paragraphe est l'ensemble des caractères compris entre deux pieds de mouche ¶ appelés 
plus souvent marques de paragraphe ou encore marqueur de paragraphe.

En haut de page, le paragraphe commence directement sur la marge haute.

La fin du paragraphe est obtenue par la Touche Entrée

Un paragraphe est 
✓soit vide, chaque appui sur la touche Entrée en crée un nouveau ¶

✓soit formé d'une ou plusieurs lignes,
 le retour à la ligne se faisant automatiquement
 ou étant provoqué par un retour-chariot Maj + Entrée  ↵

1.2. Le paragraphe, base de la mise en page

Chaque  paragraphe  de  texte  peut  être  considéré  comme  contenu  dans  un  rectangle 
imaginaire dont on peut fixer la largeur. Par défaut, cette largeur est délimitée à gauche 
et à droite par les marges de la page.

Contrairement à un logiciel de mise en page (P.A.O. : Pagination Assisté par Ordinateur) 
ce rectangle de texte ne peut être placé n'importe où dans la page. 
L'utilisation des Tableaux ou des Cadres permettra cependant de s'en approcher.

Sa position se règle par rapport à la page et à ses autres éléments. Il reste cependant 
solidaire du texte des autres paragraphes : OOo Writer reste un traitement de texte !

Traiter le texte, c'est gérer la disposition de chaque paragraphe dans la page.

La présentation d'un paragraphe dépend :

Paragraphe précédent

↕
➋ De sa distance
à la marge gauche 
= retrait gauche

 ➊ du formatage de son contenu :
alignement, interligne,

 police et attributs de ses caractères,
 tabulations, bordures et arrière-plan.

➌ De sa distance
à la marge droite
= retrait droite

↕➍ de l'espacement avec les autres paragraphes

Paragraphe suivant
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1.3. Sélection des paragraphes

1.3.1. Sélection d'un seul paragraphe

Pour appliquer un formatage, il n'est pas nécessaire de sélectionner le paragraphe par un 
déplacement de la souris alors qu'un copier-coller nécessite sa sélection complète.

Il suffit que ce paragraphe soit actif,c'est-à dire que le point d'insertion  y clignote déjà 
(en cours de frappe ou si une sélection partielle y figure).

Un simple clic sur le paragraphe positionne le point d'insertion qui clignote : 
son style, sa police et sa taille s'affichent dans la barre de formatage. 

Avant toute action, vérifiez toujours où se trouve le point d'insertion  .

La position du point d'insertion  est  importante :
 placé sur un mot, il permettra ensuite de le sélectionner ou de copier son format ( voir 
le tutoriel les Caractères)
 placé dans un espace ou entre le dernier caractère et le signe ¶, seul le paragraphe 
sera concerné.

1.3.2. Sélection de plusieurs paragraphes

Pour sélectionner un ou plusieurs paragraphes, voir le B.A.-BA , un simple Rappel :
 Par quadruple cliqué pour un seul paragraphe,
ou

 Utiliser le Cliquer-glisser : faire glisser le curseur texte  du premier caractère 
jusqu'à la fin du ou des paragraphes choisis.
ou
 Comme sélection multiple 

Touche Majuscule maintenue appuyée, cliquer à 
gauche du premier caractère, puis cliquer à la fin du 
ou des paragraphes choisis. 

On peut avec cette méthode se déplacer avec les touches 
directionnelles du clavier    

ou
 Comme sélection disjointe

Après une première sélection pratiquée de n'importe quelle manière, 
Touche Ctrl enfoncée et sélectionner par la souris un autre paragraphe 
ou plusieurs si nécessaire.

2. Formatage du contenu du paragraphes
La mise en forme des caractères ou formatage se fait de façon complémentaire : 

 avec la barre de menu Formatage et la Règle horizontale
 avec la fenêtre Paragraphe qui comporte tous les réglages.

Toute modification faite par la barre de formatage ou par la fenêtre de paramétrage 
se rajoute en plus aux caractéristiques sans modifier le style actif.

On parle alors de surcharge si une accumulation de format successifs est très 
importante 

Le but de ce chapitre est simplement de découvrir les outils de mise en forme des 
paragraphes. 

Pour le tutoriel, les exemples des paragraphes formatés sont encadrés de vert afin de 
visualiser le rectangle fictif de leur positionnement dans la page.
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2.1. La barre de Formatage

Cette barre est commune avec le formatage des caractères.

2.1.1. Police de caractères.

Bouton  Nom de Police  

Il permet le choix de la Police à appliquer au paragraphe actif.

Nous allons choisir une Police libre qui possède les deux catégories de fontes :
Bitstream Vera Serif pour les textes à imprimer,
Bitstream Vera Sans pour les textes sur écran.

➊ Sélectionnez le(s) paragraphe(s) à mettre en 
forme.

➋ Cliquez sur le bouton de la liste déroulante Nom 

de Police 

➌ La liste alphabétique des polices se déroule et 
affiche les 12 polices qui suivent celle qui est 
affichée dans le cadre.
(Ici Times New Roman)
Utilisez l'ascenseur pour atteindre la police 
désirée ou Tapez les 2 ou 3 premières lettres 
de la Police désirée, ici par exemple bit

➍ Cliquez sur la Police choisie : 
Bitstream Vera Sans

Exemple:

➊ ➍ Art poétique de Verlaine¶

2.1.2. Taille des Caractères

Bouton   Taille de Police  

Il permet le choix de la Police à appliquer au paragraphe entier.

➊ Sélectionnez le(s) paragraphe(s) à mettre en forme.

➋ Cliquez sur le bouton de la liste déroulante Taille de Police 

La liste  des Tailles  de police  se  déroule  et  affiche les  10  tailles  qui 
suivent celle affichée dans le cadre.(Ici 12)

➌ Utilisez l'ascenseur pour atteindre la taille désirée.

➍ Cliquez sur la taille choisie pour valider.

Ou bien :

➋ Sélectionner directement le nombre affiché dans le cadre 

➌ Taper une valeur numérique

➍ Valider par la touche Entrée.  
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Exemple:

➊ ➍ Art poétique de Verlaine¶

2.1.3. Styles Gras, Italique et Souligné

Boutons   Style   . Ils appliquent ces attributs au paragraphe actif.

➊ Sélectionnez le(s) paragraphe(s) à mettre en forme.

➋ Cliquez sur le bouton  pour obtenir le paragraphe en gras

sur le bouton  pour obtenir le paragraphe en italique 

sur le bouton  pour obtenir le paragraphe souligné.

Exemples : Texte d'exercice

Art poétique de Verlaine

De la musique avant toute chose
Et pour cela préfère l'Impair

Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

Strophe : Normal Times 9

 +   + 

Tableau d'exercice:

Strophe : Normal Times 10

Art poétique de Verlaine

De la musique avant toute chose
Et pour cela préfère l'Impair

Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

Art poétique de Verlaine

De la musique avant toute chose
Et pour cela préfère l'Impair

Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

Art poétique de Verlaine

De la musique avant toute chose
Et pour cela préfère l'Impair

Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

 +   + 

Art poétique de Verlaine

De la musique avant toute chose
Et pour cela préfère l'Impair

Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

Art poétique de Verlaine

De la musique avant toute chose
Et pour cela préfère l'Impair

Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

Art poétique de Verlaine

De la musique avant toute chose
Et pour cela préfère l'Impair

Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.
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2.1.4. Alignements

Boutons  Alignements 
Ils permettent d'aligner la ligne de texte sur la marge de gauche ou de droite (le fer à gauche 
ou fer à droite des imprimeurs) ou de centrer le texte dans la ligne. 
Cliquez sur le paragraphe ou sélectionnez les paragraphes à mettre en forme.

1.Alignement à gauche 

Cliquez, s'il n'est pas déjà sélectionné, sur le bouton Aligné à gauche  

C'est généralement le bouton sélectionné par défaut avec un fond encadré 

2.Alignement centré 

Cliquez sur le bouton Centré  , (une fois le texte sélectionné).

3.Alignement à droite 

Cliquez sur le bouton Aligné à droite  , (une fois le texte sélectionné).

4.Alignement Justifié

La  justification  d'un  texte  doit  se  faire  en  dernier  réglage,  si  tel  est  votre  option  :  le 
programme augmente les espaces entre les mots afin d'étendre la ligne à toute la largeur 
possible.
Le retour chariot et la marque de paragraphe conservent l'espace vide à droite.

Cliquez sur le bouton Justifié  , (une fois le texte sélectionné). 
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2.1.5. Numérotation et puces

Boutons  Les deux boutons (Dés)activer la numération et (Dés)activer les puces 
s'appliquent à une liste d'éléments pour les mettre en valeur.

A n'employer que dans des cas bien précis et limités, comme dans une lettre par exemple.

Ces icônes insèrent des numéros ou puces au format Standard devant chaque début de 
paragraphe.

Les autres formats seront traités hors initiation car la numération nécessite une approche 
particulière pour éviter des problèmes récurrents de mise en page pour les documents 
importants. Le choix des puces se fait par Menu : Format > Puces et numérotation...>

Exercice 1 : Sélectionnez les deux strophes avec le paragraphe vide et clic sur le bouton :  

Texte de départ  (Dés)activer la 
numération

  (Dés)activer les puces

De la musique avant toute chose
Et pour cela préfère l'Impair
Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

Il faut aussi que tu n'ailles point
Choisir tes mots sans quelques méprise
Rien de plus cher que la chanson grise
Où l'Indécis au Précis se joint.

Résultat à obtenir
1. De la musique avant toute chose

Et pour cela préfère l'Impair
Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

2.
3. Il faut aussi que tu n'ailles point

Choisir tes mots sans quelques méprise
Rien de plus cher que la chanson grise
Où l'Indécis au Précis se joint.

Résultat à obtenir
● De la musique avant toute chose

Et pour cela préfère l'Impair
Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

●
● Il faut aussi que tu n'ailles point

Choisir tes mots sans quelques méprise
Rien de plus cher que la chanson grise
Où l'Indécis au Précis se joint.

Pour supprimer le numéro ou la puce devant le paragraphe vide, cliquez juste devant le ¶ 
puis touche Retour arrière 

ou touche  Entrée 
ou clic sur le bouton (Dés)activer la numération

Numérotation de chaque ligne : Voici une mauvaise solution mais qui a sa place ici.
(Chaque ligne est un paragraphe !)

Exercice 2 : Sélectionnez les deux strophes avec le paragraphe vide et clic sur le bouton :  

Texte de départ   (Dés)activer la numération

De la musique avant toute chose
Et pour cela préfère l'Impair
Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

Il faut aussi que tu n'ailles point
Choisir tes mots sans quelques méprise
Rien de plus cher que la chanson grise
Où l'Indécis au Précis se joint.

Résultat à obtenir
1. De la musique avant toute chose
2. Et pour cela préfère l'Impair
3. Plus vague et plus soluble dans l'air
4. Sans rien en lui qui pèse ou qui pose.
5.
6. Il faut aussi que tu n'ailles point
7. Choisir tes mots sans quelques méprise
8. Rien de plus cher que la chanson grise
9. Où l'Indécis au Précis se joint.

Clic entre 5. ¶ et touche Exercice 3  Sélectionner strophe par strophe

Résultat à obtenir
1. De la musique avant toute chose
2. Et pour cela préfère l'Impair
3. Plus vague et plus soluble dans l'air
4. Sans rien en lui qui pèse ou qui pose.

5. Il faut aussi que tu n'ailles point
6. Choisir tes mots sans quelques méprise
7. Rien de plus cher que la chanson grise
8. Où l'Indécis au Précis se joint.

Résultat à obtenir
1. De la musique avant toute chose
2. Et pour cela préfère l'Impair
3. Plus vague et plus soluble dans l'air
4. Sans rien en lui qui pèse ou qui pose.

1. Il faut aussi que tu n'ailles point
2. Choisir tes mots sans quelques méprise
3. Rien de plus cher que la chanson grise
4. Où l'Indécis au Précis se joint.
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2.1.6. Couleur de police 

Bouton ➏ Couleur de police 

➊ Sélectionnez le(s) paragraphe(s) à mettre en forme.

➋ Cliquez sur le bouton  pour appliquer la couleur affichée (ici rouge)

Ou pour choisir une autre couleur

Cliquez sur le triangle ▾  pour faire apparaître la palette.

Un passage de la souris vous renseigne sur le nom de la 
couleur 

Cliquez sur la couleur que vous désirez.

La palette de couleur est détachable par un cliquer-glisser sur 
son titre Couleur de police.

Un clic sur sa croix  de fermeture la fait disparaître 

Exercice: Sélectionnez le Titre en entier et appliquez une couleur de police
Départ Sélection Résultat

Art poétique de Verlaine Art poétique de Verlaine

Art poétique de Verlaine Art poétique de Verlaine

2.1.7. Couleur de fond de caractère : Trame de fond

Bouton ➐ Trame de fond  des caractères 

La couleur ne s'applique qu'«en-dessous » des caractères, genre sur-lignage de MsWord.

➊ Sélectionnez le(s) paragraphe(s) à mettre en forme.

➋ Cliquez sur le bouton  pour appliquer la couleur affichée 
(ici jaune)

Ou pour choisir une autre couleur

Cliquez sur le triangle inversé  pour faire apparaître la 
palette.

Cliquez sur la couleur que vous désirez.

La palette Trame de fond est également détachable.

La palette de couleur de OOo peut être enrichie par  des couleurs personnelles.
La procédure sera expliquée à la fin de cette initiation.

  Aller à : De la couleur avant toute chose
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2.1.8. Couleur d'arrière-plan de paragraphe 

Bouton ➑ Couleur d'arrière plan   du paragraphe.

La couleur s'applique sur toute la largeur du paragraphe actif.

➊    ,  Cliquez dans le paragraphe ou sélectionnez les 
paragraphes à mettre en forme.

➋ Cliquez sur le bouton pour appliquer la couleur affichée 
(ici jaune pâle)

Ou pour choisir une autre couleur 

Cliquez sur le triangle inversé  pour faire apparaître la 
palette.
Cliquez sur la couleur que vous désirez.

La palette Arrière-plan est également détachable par cliquer-
glisser sur son bandeau de titre 

La méthode du « Pot de peinture ne s'applique pas à l'arrière plan de paragraphe.

2.1.9. Résumé pour les boutons de couleur

En gardant la visualisation des rectangles virtuels du paragraphe,
 voici le résumé des 3 boutons
 Couleur de police, Couleur de trame et Couleur d'arrière-plan.

Sur votre document de travail, vous devriez obtenir sans les encadrements des rectangles 
virtuels ceci :
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Couleur d'arrière-plan jaune pâle

Trame de fond jaune

Combinaison

+

Couleur d'arrière-plan jaune pâle

Trame de fond jaune

Combinaison+



2.2. Supprimer un formatage 

2.2.1. Supprimer par action du même bouton

Les boutons Styles  , Alignements  , Numéro ou Puces   sont des 
boutons à effet réversif, il suffit de resélectionner et d'appliquer une fois le bouton 
correspondant qui apparait parfois avec un fond plus grisé et encadré.

Exemple avec le bouton Gras, Centré et numérotation 

Départ Sélection + Bouton Résultat

 + 

+ +

 +

+

+

2.2.2. Supprimer en annulant des dernières mises en forme

Par utilisation de l'annulation des dernières actions par clic sur le bouton Annuler   (la 
dernières action) ou  si plusieurs actions de formatage se sont succédées.

2.2.3. Supprimer par le Formatage par défaut 

Le Menu > Format > Formatage par défaut applique le formatage standard au paragraphe.

Il vous indique le raccourcis clavier 

Ctrl+Maj+Espace 

J'indique la procédure avec ce raccourci clavier ( en ➋ ) mais on peut cliquer sur  Formatage 
par défaut  dans le menu, ce qui revient au même.

Suivant la manière de sélectionner le paragraphe, le résultat va être différent :

Première manière: simple clic :

 ➊ Pointez le curseur texte  dans un espace, entre 2 mots ou juste avant le ¶ .

 ➋ Maintenez appuyées les touches Ctrl et Maj puis tapez la touche espace 

Résultat :  ( seul l'attribut Centré est supprimé)

Deuxième manière : sélection totale :

➊ Sélectionnez le ou  les paragraphes

➋ Maintenez appuyées les touches Ctrl et Maj puis tapez la touche espace 

Résultat :  ( les attributs centré ET le Gras + Rouge sont supprimés)
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2.2.4. Supprimer par clic droit du Formatage par défaut

Cette méthode se retrouve par  un clic droit et la première option du menu contextuel

1.Suppression du seul formatage de paragraphe 

Pointez le curseur texte  dans un espace, entre 2 mots ou juste avant la marque de 
paragraphe.

Clic droit 
Sélectionnez Par défaut en haut du menu 
contextuel

Exercice :

Départ Sélection + clic droit Résultat

Art poétique de Verlaine
(Centré) (Aligné à gauche)

2.Suppression de l'ensemble des formats

Sélectionnez le(s) paragraphe(s)
➊ Clic droit 
➋ Sélectionnez Par défaut en haut du 
menu contextuel

Exercice: 
Départ Sélection + clic droit Résultat

Art poétique de Verlaine
(Centré) (Aligné à gauche)

Appliquez le formatage par défaut a pour effet de supprimer 
les attributs qui ont été ajoutés au dessus du style indiqué 
dans le cadre des Styles de la barre de formatage.

2.2.5. Supprimer par application du style standard

Pour les paragraphes, c'est un coup d'œil appuyé vers l'utilisation des styles!
La procédure ne change que dans le déplacement de la souris !

 ➊ Pointez le curseur n'importe où dans le paragraphe. Le point d'insertion clignote.

➋ Cliquez sur Standard  
dans le cadre de la liste déroulante 

Appliquer un Style 

au besoin faire apparaître Standard 
en déroulant la liste au moyen du petit 

triangle  

Résultat : 
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2.2.6. Supprimer par Effacer le formatage

 ➊ Pointez le curseur n'importe où dans le paragraphe. Le point d'insertion clignote.

➋ Cliquez sur Effacer le formatage  
dans le cadre de la liste déroulante 
Appliquer un Style 

au besoin faire apparaître Effacer le 
formatage qui se trouve toujours au 
sommet de la liste 
en déroulant celle-ci au moyen du petit 

triangle  

Le résultat est le même, 

Si vous sélectionnez le paragraphe en entier, le formatage sera détruit en totalité comme 
dans les méthodes précédentes.

La méthode à mémoriser : Ctrl+Maj+Espace 
2.3. Dupliquer un formatage

2.3.1. Utilisation du copier-coller

Cette utilisation est parfois très utiles pour certaine tâches. Elle consiste à copier un 
paragraphe formaté, de le coller puis de modifier son contenu.
La méthode est identique avec le Cliquer-glisser+Ctrl-  

2.3.2. Le bouton Pinceau.

Un clic sur le bouton Pinceau   permet un unique collage du format.
Un double-clic sur le bouton Pinceau permet une succession de collage du format.

➊ Cliquer sur le paragraphe comportant le format à copier

➋ Cliquer sur le bouton Pinceau :  
le curseur se transforme en «pot de peinture» :  , le format est copié.

➌ Collage du format : Un simple clic dans le paragraphe applique le format .

Résultat:
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Attention si la partie où est inséré le point d'insertion comporte des attributs supplémentaires 
comme ici le Verdana 14 gras rouge, ceux-ci risquent d'être copiés.

Résultat : 

Afin d'éviter ce genre de collage, placez le point d'insertion sur un espace ou juste avant le 
signe ¶ de fin de paragraphe.

Exercices Voici les textes proposés : Copiez les puis supprimez leur formatage suivant les différente méthodes. 
Retrouvez les différents attributs  et/ou entraînez-vous

Départ Sélection + Bouton

Art poétique de Verlaine

De la musique avant toute chose
Et pour cela préfère l'Impair
Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

Il faut aussi que tu n'ailles point
Choisir tes mots sans quelques méprise
Rien de plus cher que la chanson grise
Où l'Indécis au Précis se joint.

Menu > Format > Formatage par défaut
par un clic
par une sélection du paragraphes

Ctrl+Maj+Espace
par un clic
par une sélection du paragraphes

Clic droit et « Par défaut »
par un clic
par une sélection du paragraphes

Application du style standard

par un clic
par une sélection du paragraphes

Application Effacer le formatage »
par un clic
par une sélection du paragraphes

Dupliquez les formatage 
Utiliser le bouton pinceau

par un clic
par un double clic

Art poétique de Verlaine

De la musique avant toute chose
Et pour cela préfère l'Impair
Plus vague et plus soluble dans l'air
Sans rien en lui qui pèse ou qui pose.

Il faut aussi que tu n'ailles point
Choisir tes mots sans quelques méprise
Rien de plus cher que la chanson grise
Où l'Indécis au Précis se joint.
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2.4. La fenêtre de format des paragraphes 

2.4.1. Ouverture de la fenêtre Paragraphes 

 ✓ Soit par la barre de Menu :
Menu > Format > Paragraphe...

 ✓ Soit par le menu contextuel en cliquant droit dans la page

2.4.2. Fenêtre ou boite de dialogue Paragraphe
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2.4.3. Réglage de l'interligne

Dernier attribut de l'onglet Retrait et espacement qui s'ouvre par défaut,
l'espacement entre les lignes permet au rectangle virtuel de varier sa hauteur en 
augmentant l'intervalle entre chaque ligne du paragraphe. 

Cet interlignage est intéressant pour les lettres comportant que peu de texte ,
l'interlignage double remplacera avantageusement l'interligne simple du réglage par 
défaut.

Trois accès pour effectuer ce réglage 

1. Par le clic droit sur le paragraphe
Choisir Interligne dans le menu 
contextuel
Clic sur le petit triangle

2. Par les Boutons Interlignage à faire 
apparaître dans la barre de formatage
Voir Personnalisation des barres de 
menu

 Allez à Personnalisation

3. Par la fenêtre Paragraphe
Onglet retrait et espacement 
Attribut Interlignage : 
Choisir dans sa liste déroulante la 
hauteur d'espacement voulu.

Les trois premières options sont 
automatiques : x1,5 ou x2 simple 

Simple 1,5 ligne Double

De la musique avant toute chose,
Et pour cela préfère l'Impair,
Plus vague et plus soluble dans l'air,
Sans rien en lui qui pèse ou qui pose.

De la musique avant toute chose,
Et pour cela préfère l'Impair,
Plus vague et plus soluble dans l'air,
Sans rien en lui qui pèse ou qui pose.

De la musique avant toute chose,

Et pour cela préfère l'Impair,

Plus vague et plus soluble dans l'air,

Sans rien en lui qui pèse ou qui pose.

Pour les quatre autres options, la case à droite est activée afin d'y choisir une valeur 

ou 

Proportionnel 70% Minimum de 1 cm Typographique de 0,8 cm

De la musique avant toute chose,
Et pour cela préfère l'Impair,
Plus vague et plus soluble dans l'air,
Sans rien en lui qui pèse ou qui pose. De la musique avant toute chose,

Et pour cela préfère l'Impair,

Plus vague et plus soluble dans l'air,

Sans rien en lui qui pèse ou qui pose.

De la musique avant toute chose,

Et pour cela préfère l'Impair,

Plus vague et plus soluble dans l'air,

Sans rien en lui qui pèse ou qui pose.

Retour au Sommaire Les paragraphes Page 17 sur 45



3. Le paragraphe dans la page
Nous avons vu que l'alignement fait déjà partie de ce formatage puisqu'il dispose un texte le 

long de la marge gauche, au milieu où à coté de la marge droite, mais cela n'est bien 
visible que dans l'exemple de la poésie.

La disposition d'un paragraphe dans la page se réalise par l'utilisation des retraits et des 
espacements entre les paragraphes.

3.1. Retraits

Pour réduire la largeur du rectangle virtuel du paragraphe, il faut fixer la distance entre les 
marges de la page et les bords du paragraphe : ce sont les retraits.

3.1.1. Retraits et Règle horizontale

La méthode la plus simple est d'utiliser la Règle horizontale et ses curseurs

Dès que le curseur d'insertion clignote dans un paragraphe, la règle affiche sa largeur.
Il suffit donc de cliquer sur le paragraphe choisi pour le sélectionner.
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En déplaçant par cliquer-glisser les triangles  des curseurs, le rectangle texte voit sa 
longueur réduite. 

Le texte s'adapte automatiquement entre les 2 curseurs.

Le curseur bas  de gauche entraîne son curseur supérieur et non l'inverse.

Marge de 
la page

Curseur Retrait de première ligne Curseur Retrait avant le texte

Curseur du bas 

Exemple : Effectuer un retrait avant le texte de 1 cm :

Pour mieux voir les effets, montez votre paragraphe actif par l'ascenseur de votre fenêtre 
juste sous la règle comme l'exemple. 

Cliquez n'importe où dans le paragraphe pour le sélectionner.

Déplacez le curseur bas  vers la droite d'un cm.; c'est tout !
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3.1.2. Retrait de première ligne

La première ligne d'un paragraphe fait parfois l'objet d'un retrait particulier à gauche : retrait 
de première ligne : il est de 2 cm dans la présentation d'une lettre à la française.

Marge de 
la page Retrait

Déplacement du seul 
curseur du haut :

Retrait de première ligneRetrait de première ligne

Exemple: A partir de l'exemple précédent, création d'un Retrait de 1ère ligne de 1cm.
Déplacez du curseur haut d'un cm vers la droite.

A propos des curseurs

Sélectionné seul, le curseur haut  , retrait de 1ère ligne, est libre de mouvement :

le retrait de 1ère ligne peut être, par rapport au curseur bas pris comme Origine, 

négatif à gauche  positif à droite .

Le curseur bas entraîne le curseur haut dans son déplacement, la taille du retrait de 1ère ligne 
est conservée.

La touche Ctrl enfoncée permet de déplacer le curseur bas 
sans déplacer le curseur de retrait de 1ère ligne.

3.1.3. Utilisations des Boutons de la barre de formatage

Le bouton  permet de réduire le retrait avant le paragraphe.

Le bouton  permet d'augmenter le retrait après le paragraphe 

leurs petites flèches rouges sont explicites. Le déplacement se fait par pas de 1,25 cm à 
chaque clic sur le bouton.

Le réglage de retrait de 1ère ligne est conservé lors de l'utilisation de ces boutons.
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3.1.4. Retraits par la fenêtre de formatage des paragraphes

1.Rappel : Ouverture de la fenêtre Paragraphes 

✓ Soit par la barre de Menu :
Menu > Format > Paragraphe...

✓ Soit par le menu contextuel en cliquant droit 
dans la page

Onglet Retrait et espacement

Mini-écran qui visualise les choix

➋

➌

➊

Listes 
numériques 
de réglage 

Après avoir choisi les paramètres, vous validez par le bouton OK de la fenêtre 

2.Retrait

Sous l'onglet Retrait et espacement ,

Attribut Retrait 
Avant le texte

Choisir par la liste numérique  ,la valeur en cm du retrait à gauche. 

Exemples :

Retrait «Positif»

Retrait «Négatif»

Retrait Après le texte

Choisir par la liste numérique  ,la valeur positive ou négative du retrait 
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Cadre de visualisation
Le mini écran permet de visualiser la position du texte dans la page blanche en fonction des 

choix. 

Par défaut Avant le texte Après le texte Avant & après

Nota: La représentation du paragraphe en gris foncé avant réglage est par défaut comme sur 
la copie d'écran quelque soit le paragraphe sélectionné. La modification Après le texte 
n'y est visualisée qu'à partir d'un retrait de 2,30 cm.

Exemple d'un double retrait Avant et Après le texte :

3.Retrait de première ligne

Retrait Première ligne 

Choisir par la liste numérique  ,la valeur en cm du retrait de première ligne.

Retrait de première ligne valeur positive

Retrait de première ligne valeur négative
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Case à cocher : Retrait Automatique 

3.2. Espacement

L'espacement est la distance entre deux paragraphes.

Il est calculé automatiquement par le OOo en fonction de la taille de Police.

Il est aisé dans une simple lettre de créer des 
espacements en frappant sur la Touche 
Entrée autant de fois que nécessaire.

La possibilité de créer des paragraphes vides 
avec différentes tailles permet même de 
créer des espacements réguliers.

Cette procédure est cependant à éviter lors 
d'une utilisation intensive du Traitement de 
texte, l'usage des styles de paragraphe 
apportant une solution élégante et rapide.

Ouvrir la fenêtre Paragraphe pour régler les espacements entre les paragraphes.

Sous l'onglet Retrait et espacement 

Attribut Espacement .

Par défaut, l'espacement est fixé à 
0,00 cm

Pour fixer une valeur d'espacement, 
choisir une valeur (ou la taper au 
clavier) dans le cadre numérique 

Exemple: 
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3.3. Suppression des paragraphes et des marques de paragraphe 

La suppression d'un paragraphe dans Writer répond à sa propre logique et provoque pas mal 
de déboires pour les utilisateurs d'autres traitements de texte.

Heureusement qu'il existe l'icône Annuler 

qui permet de rattraper pas mal d'erreurs, pourtant il suffit ??? d'avoir en tête ces 3 règles:

1. La position du point d'insertion détermine le paragraphe actif .

2. La touche Retour arrière  efface ce qui est avant le point d'insertion.

3. La touche Suppr  efface ce qui est devant le point d'insertion.

En plaçant le curseur à la fin d'un paragraphe, donc avant le pied de mouche ¶
vous déterminez le paragraphe actif 

En appuyant sur Supp , vous effacer la fin du paragraphe, donc le texte suivant appartient 
alors à ce paragraphe actif
Le texte « remonte » et prend le style du paragraphe actif.

Paragraphe 1 actif centré | ¶  

Paragraphe 2 à la bordure gauche¶ 

Paragraphe 1 actif centré | Paragraphe 2 à la bordure gauche¶

En plaçant le curseur en début de paragraphe, vous déterminez le paragraphe actif 

En appuyant sur Retour arrière, vous effacer la fin du paragraphe précédent et c'est le format 
du paragraphe actif qui s'appliquera alors au texte précédent.

Paragraphe 1 centré | ¶  

|Paragraphe 2 à la bordure gauche actif

Paragraphe 1 centré | Paragraphe 2 à la bordure gauche actif

Si vous cliquez sur un paragraphe vide, celui-ci sera supprimé sans agir sur le précédent ou le 
suivant : il est VIDE !
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3.4. Tabulation

Personnellement, je n'utilise que très rarement les tabulations: j'ai toujours le souvenir des 
manipulations dans le dos de la machine à écrire pour régler manuellement les taquets 
ou le souvenir de la préhistoire des traitements de texte qui ne comportaient le 
traitement des tableaux.

Une tabulation est un repère appelé taquet placé sur la Règle pour permettre d'aligner 
automatiquement le texte par rapport aux marges de la page.

Les Tabulations sont des attributs de paragraphe : chaque paragraphe peut donc avoir des 
tabulations différentes ce qui n'est pas toujours un avantage pour la mise en page d'un 
document complexe.

Les tabulations peuvent être définies directement dans la Règle, ou déterminées 
numériquement en passant par la fenêtre de paramétrage Paragraphe.

La touche Tabulation  permet de faire fonctionner ces taquets.

Dans un tableau, la touche tabulation permet de passer d'une cellule à une autre.

Pour faire une tabulation, il faut appuyer sur la touche Ctrl + Tabulation

3.4.1. Tabulations avec la Règle

Les taquets par défaut sont placés tous les 1,25 cm par le programme ; cette option est 
modifiable ainsi que les unités.

On peut placer plusieurs tabulations sur un même ligne. Ces tabulations permettent plusieurs 
types d'alignement : Cliquez sur l'icône Sélecteur de Tabulation à gauche de la règle 
autant de fois que nécessaire pour faire apparaître le type désiré.

Tabulation 
à gauche

Sélecteur de Tabulation
Les taquets par défaut disparaissent 

entre 2 tabulations manuelles

Tabulation 
à droite

Tabulation 
décimale

Tabulation 
centrée
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3.4.2. Exemples des différentes tabulations :

  Tabulation à gauche   Tabulation à droite

  Tabulation décimale   Tabulation centrée

3.4.3. Placer les taquets sur la Règle :

 Faire ré-apparaître la Règle si elle a malencontreusement disparu :
 Menu > Afficher > Cochez devant Règle

 Placez le point d'insertion | dans le paragraphe où doivent se trouver les tabulations ou 
sélectionnez les différents paragraphes concernés.

 Cliquez sur le Sélecteur de Tabulation  jusqu'à obtenir la tabulation désirée

 Cliquez directement sur la règle à la place de graduation choisie.

Répétez Cliquer pour y placer d'autres tabulations de même type

Recommencer en  si vous désirez installer d'autres types de tabulation sur la même règle : 
cliquez sur le Sélecteur de Tabulation jusqu'à obtenir la tabulation désirée

Cliquez  sur la règle à la place de graduation choisie.

Répétez Cliquer pour y placer d'autres tabulations de même type
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3.4.4. Déplacer et supprimer une tabulation

Les taquets peuvent être déplacés  par un cliquer-glisser vers la droite ou vers la gauche. Un 
guide pointillé suit le déplacement.

Pour supprimer un taquet, il suffit de cliquer-glisser sur le taquet et de le faire sortir de la 
règle vers le bas.

3.4.5. Tabulation et fenêtre de paramétrage Paragraphes

Double-cliquez sur la zone blanche de la règle. La fenêtre de paramétrage Paragraphe s'ouvre 
sur l'onglet Tabulation. Attention cependant, le double-clic crée en même temps une 
tabulation ?

Sinon méthode normale:
Soit : Menu > Format > Paragraphes...
Soit : Clic droit sur le paragraphe sélectionné > Paragraghe... du  menu contextuel.

1.A partir d'un paragraphe affichant une règle vide

➊ Sous l'onglet Tabulations

➋ Si vous avez double-cliqué sur la Règle, une tabulation indésirable s'est créée, supprimez-
la par le Bouton Supprimer ou par le bouton Supprimer tout si vous désirez retrouver 
la copie d'écran à l'identique à partir de n'importe Règle.

➌ Les attributs Type sont des boutons radios à cocher.

Le choix du bouton Décimale permet le choix par la mini case de saisie le point anglo-
saxon ou la virgule que la tabulation décimale doit utiliser comme séparateur .
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➍ Le cadre Position comporte deux zones, la Zone de saisie en haut et la liste d'affichage 
des tabulations existantes.

Tapez une valeur en cm, 6 ou 6,5  OOo se chargeant de l'affichage 6,00 ou 6,50 .

➎ Les Attributs Caractères de remplissage permettent le choix des caractères qui s'afficheront 
comme des Points de suite : ils s'affichent à gauche du taquet.

Exemples appliqués à la tabulation décimale :

Affichage caractères non imprimables En aperçu

Pointillés  

Traits interrompus courts  

Trait continu  

➏ Valider avec le bouton OK

2.A partir d'une Règle déjà formatée 

Un double-clic sur un taquet ouvre la fenêtre  Paragraphe , onglet Tabulation mais 
directement sur la tabulation correspondante, ses attributs étant sélectionnées.
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Le cadre Position comporte deux zones :
En haut, la zone Cadre de saisie qui ne contient qu'une ligne de données.
En bas, la zone cadre comportant la liste des tabulations existantes.

La sélection de la tabulation désirée s'effectue en cliquant sur une des valeurs de cette liste : 
sa valeur s'affiche alors dans le Cadre de saisie.

Les boutons radios Type et Caractères de remplissage (Points de suite) indiquent alors les 
différents attributs de la tabulation sélectionnée.

Si l'utilisation directe de la Règle est rapide pour créer les 
tabulations, la précision obtenue dépend beaucoup de votre 
doigté de souris, même si les valeurs affichées relèvent du 
dixième de millimètres !

Note : Vous avez dû déjà en cliquant droit sur la Règle voir que le 
menu contextuel propose différentes unités d'affichage de la 
Règle avec comme option  le Point, ce explique cette 
précision du dixième de millimètre.

Pour modifier la valeur numérique affichée dans le cadre de saisie :

Cliquez dans le cadre de saisie,puis :
soit cliquer-glisser pour tout sélectionner 

soit sélectionner par clavier :  +  

et tapez une valeur en cm, 5 ou 5,2 ; OOo se chargeant de l'affichage 5,00 ou 5,20cm.

3.4.6. Utilisation des tabulations

1. Au fur et à mesure de la frappe

En début de frappe ou en cours de la frappe, appuyez sur la touche Tabulation 
 Le point d'insertion saute et s'arrête au niveau de la 1ère tabulation définie.
Saisir les mentions à partir de cette nouvelle position du point d'insertion.

En appuyant une 2ème fois sur la Touche Tabulation : le point d'insertion s'arrête au niveau de 
la 2ème tabulation et ainsi de suite.

Si vous devez faire une énumération 
en allant à la ligne
 faites un retour chariot pour 
conserver le réglage du 
paragraphe !
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2. Après la frappe du texte:

➊ Tapez votre texte normalement en allant à la ligne par des retours-chariots 
➋ Insérez le point d'insertion à l'endroit désiré 
➌ Appuyez sur la touche Tabulation, et ainsi de suite

➊ Tapez votre texte normalement en allant à la 
ligne par des retours-chariots

 puis  

➋ Insérez le point d'insertion à l'endroit désiré, 
ici après J'aime 

Notez la position de la marque d'espace (le 
point médian) après le point d'insertion |

➌ Touche tabulation  
Le texte s'aligne au droit du taquet

➍ Insérez le point d'insertion à l'endroit désiré, 
ici en début de ligne. 

Notez l'absence de point médian après le point 
d'insertion |

➎ Touche tabulation  
Le texte s'aligne au droit du taquet

➏ Insérez le point d'insertion à l'endroit désiré, 
ici après déteste

Notez la position du point médian après le point 
d'insertion |

➐ Touche tabulation  
Le texte s'aligne au droit du taquet.

On s'aperçoit du manque d'alignement en 
raison d'un point médian manquant.

➑ Correction d'alignement : rétablir les points 
médian en insérant un espace à l'endroit 
nécessaire ( ici placez le point d'insertion 
devant «la bonne chère» et  tapez <esp>
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4. La décoration des paragraphes

4.1. Encadrement ( Bordure ) d'un paragraphe

L'encadrement et le soulignage du paragraphe permettent de le mettre en valeur, il faut 
cependant faire attention de ne pas trop en abuser.

Un texte surchargé est d'une lecture plus difficile.

4.1.1. Rappel : Ouverture de la fenêtre Paragraphes 

✓ Soit par la barre de Menu :
Menu > Format > Paragraphe...

✓ Soit par le menu contextuel par clic droit dans le 
paragraphe > Paragraphe...

Cliquez sur l'onglet Bordure

➊

➋ ➌

Onglet Bordure 
 = Encadrement

➍

➎

4.1.2. Disposition des lignes

Disposition des lignes de bordure propose 

Par défaut 5 choix :  

La première icône à gauche  représente «Aucune bordure».

Le mini cadre de visualisation en dessous de Défini par l'utilisateur 
n'affiche aucune ligne.

Un clic sur sur cette même icône  permet de supprimer 
toute bordure du paragraphe sélectionné.
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Cliquer sur l'une de ces 5 icônes affiche dans le mini cadre la visualisation de la bordure 
choisie 

Encadré Gauche & Droite Haut & bas A gauche seul

L'attribut Défini par l'utilisateur permet de placer un trait à l'emplacement voulu par un clic 
dans le mini cadre de visualisation.

Exemple :

Trait inférieur suivi par trait à droite suivi par trait à 
gauche

Exemple et Annulation

Pour annuler:
Cliquer sur l'icône

4.1.3. Lignes

La zone d'attributs Ligne permet de choisir le style et la couleur des traits.

Le style de chaque bordure est déterminée par le choix de 
l'épaisseur et de la combinaison des lignes.

La procédure est la suivante

➢ Pour un seul trait : 

➊ Positionnement du trait par Disposition des lignes
➋ Choix du Style 

➌ Choix de la Couleur
➢ Pour une plusieurs traits identiques : 

➊ Choix du Style et de la Couleur

➋ Positionnement des traits par Disposition des lignes

 La liste déroulante Style propose une série de bordures simples ou composées:
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Style
- Aucun(e)- permet d'effacer le  trait 

actif,

Le trait de 0,05 pt (point) est affiché 
par défaut. Il correspond à la 
ligne pointillée du mini écran.
Il est très souvent bien suffisant.

Le trait de 0,50 pt évite parfois des 
absences en aperçu avant 
impression.

Les doubles traits sont utilisés dans 
les styles de Titre et Sous-titre

Couleur
La liste déroulante de Couleur permet 

de choisir la couleurs de la 
bordure sélectionnée.

4.1.4. Espacement avec le contenu

Par défaut, dès qu'une bordure est choisie, le programme propose un espacement entre le 
texte et la bordure. En laissant cochée la case Synchroniser, les résultats sont 
satisfaisants. 

Cependant, parfois, pour une meilleur lisibilité du document, un réglage manuel n'est pas à 
négliger.

4.1.5. Ombres

Par défaut, Sans ombre est activé :

Les 2 réglages Distance et Couleur 
sont inactifs (en grisés)

Icône sans ombre non activée : 

Les autres icônes sont parlantes, avec la projection de l'ombre portée

En bas à droite En haut à droite En bas à gauche En haut à gauche

La distance de l'ombre par rapport au trait est préréglée, elle peut être modifiée avec le cadre 
numérique.
La couleur par défaut en noir doit être réglée en une nuance de gris par la liste déroulante (ou 
dans une autre nuance de couleur)

4.1.6. Exemples 

Exemple n°1 : Réalisez l'encadrement d'un paragraphe comme pour le rectangle virtuel du 
tutoriel :

Sélection du paragraphe, clic droit et choix de Paragraphe... du menu contextuel >
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Cliquez sur l'onglet Bordure : 

Choisir le Style de la ligne : 0,05 pt

Choisir la Couleur : Vert clair

Choisir la Disposition des lignes : Par défaut : Encadré 

Laissez cochée Synchroniser et la proposition par défaut de Espacement( 0,05 cm).

Exemple 2: Réalisez la bordure utilisée pour le soulignement des titres du tutoriel

Voici les réglages permettant ce soulignement.

Exemple 3 : Réalisez la bordure utilisée pour le soulignement de ses Sous-titres.

Voici les réglages permettant ce soulignement.

4.1.7. Réduction de la bordure d'un paragraphe

La bordure est liée au rectangle virtuel : il faut donc utiliser les Retraits de paragraphes. 

Pour obtenir un encadrement sur un texte aligné à gauche : 

Après ou avant la réalisation de la bordure, 
il faut augmenter le retrait à droite du 
texte en déplaçant le curseur de la 
règle.
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Pour obtenir un encadrement sur un texte centré :

Il faut augmenter les retraits à gauche et à droite du texte afin de réduire la largeur du 
rectangle virtuel.

Une fois le texte centré  , amenez les deux curseurs bas  le plus près du texte possible, 
puis toujours en se servant de la Règle, déplacez les afin de créer deux espaces égaux à 
gauche et à droite du texte.

4.2. Bordure avec couleur d'arrière-plan

4.2.1. Onglet Arrière-plan de la fenêtre Paragraphes

Onglet Arrière-plan

➊

➋

Onglet Arrière-plan 

Par défaut, 
Sans remplissage

Choisir une 
couleur

Attribut Type   

La  couleur  choisie  s'applique  sur  toute  la  largeur  du  paragraphe  actif.

Exemple : En appliquant cette couleur d'arrière plan aux cadres précédents,
vous devriez obtenir ceci:

La couleur d' Arrière-plan de paragraphe s'obtient aussi avec le Bouton Couleur d'arrière 

plan   de la Barre de Formatage.
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4.2.2. Image insérée comme arrière-plan = filigrane 

Le second choix de la liste déroulante Type permet d'insérer comme arrière plan une image 
dans un seul paragraphe : cette méthode est assez surprenante pour un débutant qui 
tente d'insérer une image dans un paragraphe d'une seule ligne et oublie que le 
paragraphe peut comporter autant de lignes créées automatiquement que créées avec 
des retours-chariots : voir « Image dans un seul paragraphe : attention ! » 

MAIS la meilleure méthode est d'insérer simplement l'image dans le document 

5. Filigrane dans un paragraphe
Nous quittons le niveau de la pure 'initiation pour aborder effleurer quelques possibilité de 

Writer. Que le débutant prenne patience, et aborde ces  chapitres avec un œil serein.

Ce chapitre traite de l'insertion des images plus ou moins transparentes en proposant un 
choix très large de réglages pour filigraner un logo ou une photo... pour finir par le 
filigrane traditionnel qui est l'image-texte grisée que l'on trouve en arrière plan.

On retrouvera l'insertion d'images filigranées dont l'usage est beaucoup plus répandu sur une 
Page dans l'étude des Styles de Page.

5.1. Insertion d'une image dans un document 

L'insertion d'une image dans un paragraphe est simple 

Menu : Insertion > Images. 

En choisissant A partir d'un fichier,
la boite de dialogue Insérer une image permet de naviguer jusqu'au fichier image à choisir, 
cliquer dessus puis valider avec le Bouton Ouvrir

L'image s'insère telle qu'elle existe
et la barre d'outil Image s'affiche.

Son menu déroulant du Style propose :
Standard, l'image est telle quelle.
Filigrane, l'image est en transparence 
préréglée.
Noir/Blanc, ou Niveau de gris, l'image se 
transforme en conséquence

Standard Niveau de gris Noir et blanc Filigrane

Un clic, l'image se sélectionne avec ses poignées vertes, dimensionnez-la suivant votre désir.

Un double clic sur l'image, la barre de dialogue Image s'affiche.
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5.2. Transformer une image en arrière-plan

Pour transformer cette image en arrière-plan, afin de pouvoir écrire dessus,

Laisser l'image en Standard
clic droit sur l'image >

choisir les attributs suivants:

Ancrage > Au paragraphe

Adaptation du texte > 
Continu
puis
A l'arrière plan 

Image >Vous accéder également à la 
Boite de dialogue  Image

Vous obtenez (comme par le double-clic sur l'image) cette boite de dialogue Image  où vous 
retrouvez les différents réglages de l'image sélectionnée.

Image 

Onglet :
Adaptation du texte 

Définitions : Continu
à cliquer

Options : A l'arrière plan 
à cocher.

Note : pour accéder au 
texte, il suffit 
parfois de déplacer 
légèrement l'image 
sauf si celle-ci a été 
« protégée »

La protection ou la 
déprotection de 
l'image s'obtient 
par la même boite 
de dialogue,

Onglet Options:
Cocher les cases 
souhaitées 
:Contenu,
Position
et/ouTaille
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5.3. Exemple d'une image centrée avec un fond de texte :

Image : Verlaine 4,5 cm x 6,18 cm, un texte doit être centré au bas de l'image 

➊Taper le texte suivant et centrer le paragraphe.
utilisez bien le retour chariot ( 1 seul paragraphe !)

Art poétique
Verlaine

par Fantin Latour

➋Modifier la couleur des 
caractères en mettent du 
rouge et du blanc par 
exemple 

Art poétique
Verlaine

par Fantin Latour

➌Prévoir l'espace recouvert par l'image:
clic droit > Paragraphe... Onglet Retrait et espacement > Espacement : Avant le 
paragraphe, tapez 4,20 ce qui évitera d'être obligé de créer des paragraphes vides
Placer le point d'insertion dans le texte, 

➍Insertion de l'image :
Menu : Insertion > Images >.
Suivez la procédure d'insertion

Ne vous inquiétez pas , l'image s'insère
mais n'est pas à a bonne place,  
ce qui est normal car par défaut 
elle est en « Pas d'adaptation » .

➎Transformation de l'image en Arrière plan
clic droit sur l'image  > Ancrage : Au paragraphe

Adaptation du texte : En Arrière-plan 
l'image prend la place désirée.

Art poétique
Verlaine

par Fantin Latour

➏Fixer votre image si vous en êtes satisfait :> clic droit sur l'image > Image > Image
Onglet  Options >
Protéger : Cocher Contenu, Position et Taille
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5.4. Image dans un seul paragraphe : attention !

Vous êtes dans un paragraphe et vous voulez insérer une image par 
Menu : Format > Paragraphe...> Paragraphes > 

Onglet Arrière-Plan :

Type : Image
par la liste 
déroulante à la 
place de couleur

Fichier : 
Bouton Parcourir 
pour choisir le 
fichier image

Type : 
Cocher Position
et choisir celle-ci

je centre en haut 
pour l'exemple

Valider Bouton OK

Et voici pourquoi 
ce n'est pas la 
meilleure 
méthode 

Vous obtenez ceci !:

¶

ça ne marche pas !
Erreur, cela a parfaitement fonctionné puisque votre paragraphe à la dimension du 
marqueur de paragraphe ¶ ici en police 11
L'image occupe l'espace que lui laisse le paragraphe qui n'est ici que d'une ligne !

Si vous tapez des retours chariots

↵
↵
↵
↵
↵
↵

.¶etc
l'image se dévoile.

Si vous tapez ou collez un texte de plusieurs lignes ( composé uniquement de texte avec 
seulement des retours-chariots), vous obtenez ceci 

De la musique avant toute chose

Et pour cela préfère l'Impair
Plus vague et plus soluble dans l'air

Sans rien en lui qui pèse ou qui pose.

Il faut aussi que tu n'ailles point
Choisir tes mots sans quelques méprise
Rien de plus cher que la chanson grise

Où l'Indécis au Précis se joint.

Vous pouvez modifiez les caractères dans tous leurs attributs, (taille, couleur, gras etc. mais 
ne touchez pas à la touche Entrée !
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5.5. Jouer sur la transparence : le filigrane

Entre l'image standard et le choix de filigrane de la barre d'image, il y a un choix non 
négligeable pour satisfaire les besoins d'expression.

Standard + blanc Niveau de gris50%+noir 50% + marron 1 Filigrane + orange1

Les sanglots longs
Des violons

De l'automne
Blessent mon cœur 

D'une langueur 
Monotone.

Et je m'en vais
Au vent mauvais
Qui m'emporte

Deçà, delà,
Pareil à la

Feuille morte.

Les sanglots longs
Des violons

De l'automne
Blessent mon cœur 

D'une langueur 
Monotone.

Et je m'en vais
Au vent mauvais
Qui m'emporte

Deçà, delà,
Pareil à la

Feuille morte.

Les sanglots longs
Des violons

De l'automne
Blessent mon cœur 

D'une langueur 
Monotone.

Et je m'en vais
Au vent mauvais
Qui m'emporte

Deçà, delà,
Pareil à la

Feuille morte.

Les sanglots longs
Des violons

De l'automne
Blessent mon cœur 

D'une langueur 
Monotone.

Et je m'en vais
Au vent mauvais
Qui m'emporte

Deçà, delà,
Pareil à la

Feuille morte.

Le Choix filigrane proposé par défaut est effectivement un peu pâlot, il est donc préférable de 
jouer sur la transparence de l'image insérée.

Clic sur l'image fait apparaître barre d'outil et son petit verre symbole de la transparence  ou 
du délayage ? 

Entre les différentes valeurs de transparence et e choix de choix de la palette de couleurs 
pour les caractères, l'éventail est large.

Standard
Transparence : 30 %

  Pour les artistes, cette même 
Barre d'outil 

propose une palette de 
nuance Couleur à appliquer 
à l'image, avec un même 
un correctif gamma !

Standard
Transparence : 70 %

5.6. Les Textes-images en filigrane

Même si cela existe plus fréquemment sur une page, on peut vouloir insérer un filigrane texte 
soit en image simple (qui se placera sous plusieurs paragraphe) 
soit en un filigrane attaché à un seul paragraphe.

Dans ce dernier cas, comme on vient de le voir, il faut prévoir la hauteur = le nombre de 
lignes de ce paragraphe, lignes automatiques ou provoquées par des retours-chariots 
afin de créer une image texte utilisable sans faire trop de distorsions ensuite.

La méthode consiste à créer un texte-image 'dans un nouveau document dessin  OOo Draw, 
de créer le texte , le transformer, y a porter une rotation puis de l'exporter en un fichier 
image au format .png ( ou .jpg) pour l'insérer avec l'une ou l'autre des 2 méthode.

Vous pourrez fixer ce filigrane ensuite par clic droit  > Image > Image
Onglet  Options > Protéger : Cocher Contenu, Position et Taille
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➊ Ouvrir un nouveau fichier Draw

Dans la barre d'outils Dessin, 
cliquer l'outil Texte T ,

Faire glisser le nouveau curseur 
pour former le cadre de 
texte à la dimension voulue, 
relâcher la souris

 

Taper le texte souhaité, une fois 
sélectionné, choisir sa Police, 
sa taille, sa grosseur etc,

Bistream Vera sans, 18 , gras, noir

Menu : Modifier > Rotation :
choisir  une des poignées 
rouges d'angle.

puis

Faire pivoter + ou – légèrement
Cliquer hors cadre puis       

Sélectionner pour faire apparaître 
les poignées vertes.

C'est cette sélection que l'on va 
exporter

➋ Exporter en png. 
Menu : Fichier > Exporter...>  

Boite de dialogue Exporter :
Donner un nom de fichier
Format de fichier : PNG 
(.png)

Valider par le bouton Enregistrer

Accepter les options PNG par 
défaut ( 6, Entrelacé)

Qualité maximale : 0 pas de 
compression
Entrelacé : meilleure 
transmission par le Net

➌ Importer ce fichier-image dans 
votre document.

Image Ancrage : Au paragraphe
Adaptation du texte : 
En Arrière-plan Sélection, déplacement... Transparence : 50 %

Protéger votre texte-image-même si la protection du texte se fait en utilisant les Sections
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6. De la couleur avant toute chose

6.1. Création d'une couleur spécialisée

A la limite de l'initiation, le traitement de couleurs vient naturellement après l'insertion 
d'image, alors pourquoi pas, ne pas créer une couleur qui provienne de l'image insérée ?

Menu : Outils > Options > +OpenOffice.Org > Couleur > 

6.1.1. Création d'une couleur à l'aide du spectre de couleurs

➊ Choisir la couleur qui se rapproche le plus de celle voulue, ex: Orange1

➋ Effacer le nom Orange1
➌ Cliquer sur le bouton Ajouter

➍ Nommer la couleur à créer
Verlaine1

➎ Cliquer sur le bouton Éditer

La Boite de dialogue Couleur 

affiche les données de Orange1 

Cadre à gauche par carré

Cadre de droite par curseur

en bas au milieu 
les valeurs RVB 
Rouge = 204
Vert = 102
Bleu = 51

en bas à gauche
les 2 aperçus de couleur  
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En déplaçant le curseur flèche, 
les valeurs RVB se notifient.
➏ Déplacer le curseur sur le 
spectre de couleur,
les valeurs RVB en bas et 
l'aperçu de droite varient.

Laissez les valeurs affichées ou 
tapez les valeurs que vous 
connaissez, ici 

Rouge = 143
Vert = 99
Bleu = 12

Utilisez les zones Teinte, 
Saturation et Luminosité 

➐ Validez par le bouton OK

Vous obtenez la boite de 
dialogue qui indique les 2 
aperçus différents 

en haut la couleur de départ 
Orange1 

en dessous la couleur choisie 
ainsi que ses valeurs RVB

L'icône-carré Orange1 est 
encore sélectionné dans la 
Palette de couleurs en bas.

➑Cliquer sur le bouton
Modifier

La couleur spécialisée Verlaine1 
s'est enfin créée, 

elle prend place dans la liste 
déroulante en face de 
Couleur
et possède son icône 
carrée dans la Palette des 
couleurs.

➒Valider par le bouton OK

Remarque : Commencer à l'étape ➋par effacer le nom de couleur évite quand on tape sur le

bouton Ajouter
d'afficher un 

message 
d'avertissement 

puis

 qui

ouvre la boite de saisi du nouveau nom
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6.1.2. Création avec les valeurs connues RVB de la couleur.

Même méthode, les valeurs RVB sont appliquées directement comme à l'étape 6 précédente.

Menu : Outils > Options > +OpenOffice.Org > Couleur > 

➊ Choisir n'importe quelle couleur de la palette 
➋ Effacer le nom affiché
➌ Cliquer sur le bouton Ajouter

➍ Nommer la couleur à créer
Verlaine2

➎ Tapez les valeurs RVB

➏Cliquer sur le bouton Modifier

➐ Valider par le bouton OK

6.1.3. Comment trouver les valeurs RVB

Si l'outil pipette de Draw (Dessin...) Menu : Outils > Pipette permet de modifier les couleurs de 
la palette, elle ne possède pas la fonctionnalité valeurs RVB ou autres que possèdent les 
logiciels de traitement d'image.

Pour créer une nouvelle couleur utilisable dans OOo à partir d'une photo importée sur Writer. 

Il faut utiliser la pipette de The Gimp , 
logiciel libre, mais on peut utiliser celle 
de Jasc Paint Shop ou équivalent.

Ouvrir le logiciel 

Ouvrir une copie de l'image :

Fichier >  Ouvrir... >
Choisir l'outil Pipette: : 8ème icône par 

défaut

Cliquez à l'endroit choisi 

La fenêtre Information de la pipette à 
couleurs 
vous donne par les 2 listes déroulantes 
les Valeurs des pixels et RVB (en %) 
Noter les valeurs.
Fermer 

Remarque ; The Gimp, permet 
aussi d'appliquer la pipette 
directement sur une copie d'écran :
Fichier > Acquisition > Capture 
d'écran...
WinSnap : Capture une fenêtre seule 
> Capturer 
Select Windows : Drag crosshair to 
select windows ( Glisser la croix sur 
la fenêtre à sélectionner) 
Clic avec la pipette sur la copie ainsi 
réalisée > Information de la pipette à 
couleurs 
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6.2. Encore plus loin avec Draw

Avant de clore la question des couleurs, faites un tour par un document OOo Draw et 
choisissez 

Menu : Format > Remplissage: 
Onglet Dégradé par curiosité entre autre...

en pensant à l'export .png dans vos documents texte...comme la décoration des Cadres, 
objets encore à découvrir...
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